SoA OMB Performance Management Evaluation Framework

Content Guidelines & Submission Procedures

UAA
UAF
UAS
Enterprise Entities
System Office
University of Alaska System

LAST UPDATED: May 13, 2024

Data Analysis & Institutional Research
www.alaska.edu/ir/outcomes/
# TABLE OF CONTENTS

I. PART A – CONTEXT AND GUIDELINES
   2. Content 3

II. PART B – SUBMISSION PROCEDURES
   1. Coordinators 4
   2. Definitions 4
   3. Key Dates 5
   4. Accessing State of Alaska OMB’s Alaska Budget System 6

III. OMB Alaska Budget System Performance User Guide  (Sections linked within section) 10
I. PART A – CONTEXT & GUIDELINES

1) State of Alaska Performance Management Evaluation Framework

The State of Alaska (SoA) Office of Management and Budget (OMB) administers the Performance Management Evaluation Framework:

Alaskans expect government to address a wide range of priorities, such as economic development, education, public safety, and transportation. Residents also expect a focused, effective, efficient government. Performance is the tool the Administration uses to set goals, measure progress, and be accountable to Alaskans for getting results that matter.

Performance information is submitted each year in parallel, and in compliment, to annual operating and capital budget requests to the SoA. Content is available online on the OMB website alongside budget request information, and appears in the state budget request narrative documents for each entity.

2) Content Principles

The approach to coordinating performance information for the University of Alaska budget request is similar to past years. Each coordinator, working closely with their leadership and budget development function, will select, define, report and analyze information reported for mission results and core services each year. Typically, these are informed by and closely aligned with accreditation measures and university priorities and focus areas as presented to the Board of Regents.

Coordinators are responsible to respond and address questions on aspects of the content published for their organization. Changes to content or timelines may be required by the State of Alaska Office of Management and Budget and/or the UA Board of Regents. Responsible parties will be notified, and this document will be updated with the new due dates as they occur.

Key elements of the Department Performance Detail for UAA, UAF, UAS, SO and EE include:

- Mission – Consistent with statutory authority.
- Core Services – Core activities/functions to accomplish missions.
- Results – Planned goals or achievements
- Targets – Targeted results, identified individually for End Results and Strategies, against which to measure success.
- Analysis of Results and Challenges – Data and analysis of current results and barriers to achieving success.

---

1 See https://omb.alaska.gov/performance/
II. PART B – SUBMISSION GUIDELINES

This document details procedures for UAA, UAF, UAS, SO, and EE. Procedures for the University of Alaska level report are different due to system requirements, and are available upon request.

1. Coordinators

The following persons have been designated by their respective organization as responsible to coordinate and deliver the Performance Management Evaluation Framework submission annually:

- Susan Kalina: UA Anchorage
- Chantelle McGinness: UA Fairbanks
- Kristen Handley: UA Southeast
- Gwen Gruenig: System Office
- Alesia Kruckenberg: Enterprise Entities
- Gwen Gruenig: UA System

Designation of a backup coordinator is encouraged to aid in content development and addressing questions quickly.

2. Definitions

Information published in the performance report is highly visible and widely available on the State of Alaska website. To help document the information published and how to replicate it, a definition for citation is required for each measure as part of the annual submission.

A standard template for clearly documenting each definition is available online [here](https://drive.google.com/file/d/180ssfSXTckFWuxm-ifAxmS2Ik2pn6n7T/view?usp=sharing), for convenience.

For additional information and assistance with completing definitions, please contact Kevin Swenson (kbswenson2@alaska.edu).

---

2 https://drive.google.com/file/d/180ssfSXTckFWuxm-ifAxmS2Ik2pn6n7T/view?usp=sharing
3. Key Dates

Due dates for performance evaluation tasks supporting budget development are below.

<table>
<thead>
<tr>
<th>Due</th>
<th>Responsible</th>
<th>Action/Event</th>
<th>Audience</th>
</tr>
</thead>
<tbody>
<tr>
<td>5/13/24</td>
<td>DA &amp; IR</td>
<td>Performance Management Evaluation Procedures Available – Budget Year FY26</td>
<td>All</td>
</tr>
<tr>
<td>8/30/24</td>
<td>Coordinator</td>
<td>Publish initial performance evaluation via ABS for public viewing and incorporate into UA Budget Book</td>
<td>Leadership</td>
</tr>
<tr>
<td>11/15/24</td>
<td>Coordinator</td>
<td>Publish final performance evaluation aligned with BOR adopted budget request via ABS. OMB may require approval to publish content changes</td>
<td>DA &amp; IR, SPB</td>
</tr>
<tr>
<td>11/29/24</td>
<td>OMB</td>
<td>Lock all performance evaluation content for the fiscal year</td>
<td>All</td>
</tr>
<tr>
<td>Winter 2024/Spring 2025</td>
<td>Coordinator</td>
<td>Available to provide additional information as needed on evaluation detail</td>
<td>State Relations</td>
</tr>
<tr>
<td>5/1/25</td>
<td>DA &amp; IR</td>
<td>Performance Management Evaluation Procedures Available – Budget Year FY27</td>
<td>All</td>
</tr>
</tbody>
</table>

Changes may be required mid-process by the State of Alaska Office of Management and Budget and/or the UA Board of Regents. A comprehensive calendar for the FY26 budget development cycle, including the elements noted above, is available online at: https://www.alaska.edu/swbudget/instructions-and-references/
4. Accessing State of Alaska OMB’s Alaska Budget System (ABS)

An active State of Alaska login in the form ybocxxx is required, where xxx is a user-specific designation assigned to the coordinator.

Apply for your ybocxxx account as soon as possible, as this login is required to complete all later steps. To request this, email Alesia Kruckenberg (amkruckenberg@alaska.edu) and Kevin Swenson (kbswenson2@alaska.edu).

There are two login username types are referred to in this document.

   a) short username - ybocxxx (where xxx is specific to the user)
   b) long username - ybocxxx4soa@alaska.gov (xxx specific to the user)

Several required files are provided in the shared google drive folder, OMB ABS Documents to for easy access. If assistance is needed with accessing the drive folder or using any of these files, please contact Kevin Swenson (kbswenson2@alaska.edu).

Steps to access the ABS system

1) You must either use a Windows computer or have a Windows virtual machine installed on your computer to set up access and log into ABS.

2) An active ybocxxx login is required to proceed. If you need to receive or reset the password for your ybocxxx login, contact Mark S. Feth Microcomputer/Network Specialist Office of Governor Mike Dunleavy, DESK:907.465.3874, CELL: 907.500.4926, Mark.Feth@alaska.gov

3) Apply for VPN
   It may take several business days for SoA to reply after your application is submitted, confirming that your VPN has been approved.

   a. Fill out account requestor information on pages 1 and 4 of the VPN Access Application stored in the google drive. You are not required to provide a copy of your id or your ssn. Key sections of the form have been pre-filled with the correct content for UA coordinators. Make sure the phone number on the VPN application is the best phone number to receive your temporary password via voice call.
   b. Go to https://drop.state.ak.us/drop/

---

3 https://drive.google.com/drive/u/4/folders/1H5Cv0AhxN_uFkdAy3A9NjFVHm7W2sQq
4 https://drive.google.com/file/d/1WbfkI34iQagpElzXm9laih3R9ebD7156/view?usp=drive_link

Last Updated May 13 2024
c. Click “Drop Off”
   Anyone may perform the following activities:

   ![Drop-off (upload) button]

   **Drop-off (upload)** a file for a State of Alaska user (email verification required).

   ![Pick-up (download) button]

   **Pick-up (download)** a file dropped off for you.

d. Fill out the send form.
   Information about the Sender

   ![Send form]

   **Have you been given a “Request Code”?**  
   Yes  No

   **Your name:** Your Name
   **Your organization:** University of Alaska [YOUR DEPARTMENT/MAU]
   **Your email address:** YourUAEEmail@alaska.edu

   To confirm that you are a real person (and not a computer), please complete the quick challenge below:

   ![reCAPTCHA]

   I now need to send you a confirmation email.
   When you get it in a minute or two, click on the link in it.

   **Send confirmation**

   ![Send confirmation button]

e. Click “Send Confirmation” and then check your email for an email from ZendTo. Open the link in the email.

f. Select “Add Many” and add Will Belknap (will.belknap@alaska.gov)

g. Attach the completed SoA VPN application, make sure all fields are filled out, and click “Drop-off Files” when ready to submit.

h. When the SoA confirms your VPN access, they should also include a temporary password and password resetting instructions for the VPN. If you need to receive your initial, temporary password email Will Belknap (will.belknap@alaska.gov), Alesia Kruckenberg (amkruckenberg@alaska.edu) and Kevin Swenson (kbswenson2@alaska.edu) for assistance.

4) Install State of Alaska VPN
   Login here [https://oit.alaska.gov/home/employee-dashboard/vpn/](https://oit.alaska.gov/home/employee-dashboard/vpn/) and follow the steps under part
B (sign in with the short username ybocxxx & password to get to the secure website), or download the installer for your computer and version of Windows from the shared Google Drive.

a. After installing the Cisco VPN launch the application.
b. Type in the server’s name to connect to: soaancvpn.state.ak.us
c. Click connect and when promoted for a login, use your long username ybocxxx4soa@alaska.gov, click Next and at the next window enter a password.
d. If you are prompted to set up 2 factor authentication (2FA) follow the steps, otherwise prepare for a text message (or call) to confirm your 2FA code.
e. A successful connection looks like this.

5 https://drive.google.com/drive/u/4/folders/1H5Cv0AhxN_uFkdAy3A9NjFVHm7W2sQq
5) Download the remote desktop connection file abs.rdp from the Google Drive, before you connect to the SoA VPN. This file will only run on a Windows computer. You must either be on a Windows computer or have a Windows virtual machine to open this program.

6) While connected to the SoA VPN, access to UA resources and the internet will be unavailable from your Windows computer or Windows virtual machine. To maintain productivity, save necessary files locally and consider nesting the VPN within a virtual machine. This allows your primary machine to access the UA network. The final steps involve logging into a remote Windows computer; prepare files beforehand to avoid repetitive logins and logouts.

7) Use Cisco Secure Connect to establish the connection to the state VPN: soaancvpn.state.ak.us

8) Double click on the abs.rdp icon on a Windows computer to launch the remote desktop connection wizard.

9) Enter your password and your username is “SOA\shortusername” for this login. If you are logged into Windows via your UA account, the abs.rdp program might try to connect with that username. Make sure that the abs.rdp program is logging in with your SOA username, and not UA username.

10) If you get the following error, then email Will Belknap (will.belknap@alaska.gov) and he will approve you as an authorized remote user. Remember to cc Alesia Kruckenberg (amkruckenberg@alaska.edu) and Kevin Swenson (kbswenson2@alaska.edu).

---

6) https://drive.google.com/drive/u/4/folders/1H5Cv0AhrxN_uFkdAy3A9NjFVHm7W2sQq
11) If prompted to accept a certificate, click yes.
TABLE OF CONTENTS

SYSTEM OVERVIEW ............................................................................................................................................................. 3
  REPORTING PERFORMANCE IN THE ABS BUDGET BOOK .................................................................................................................. 3
ACCESSING THE SYSTEM ................................................................................................................................................... 3
BROWSING YOUR BUDGET STRUCTURE ......................................................................................................................... 4
PUBLISHED VS DRAFT EDIT MODE .......................................................................................................................................................... 5
  PUBLISHED EDIT MODE ........................................................................................................................................................................ 5
  DRAFT EDIT MODE ........................................................................................................................................................................... 6
END RESULTS & CORE SERVICES .................................................................................................................................... 8
TARGETS ............................................................................................................................................................................. 10
EDITING TARGET DETAILS ............................................................................................................................................... 11
EDITING A TARGET’S DATA TABLE AND GRAPH .............................................................................................................. 11
CREATING GRAPHS FROM TABLES ........................................................................................................................................ 13
  SHARED FIELDS BETWEEN TABLES AND GRAPHS: .......................................................................................................................... 13
  FIELDS EXCLUSIVELY ADDED FOR THE GRAPHING FEATURE: ......................................................................................................... 13
  TECHNICAL TIPS AND KNOWN ISSUES WITH GRAPHS: ................................................................................................................ 14
  GRAPHING EXAMPLES .................................................................................................................................................................. 15
  EXAMPLE 1 – SINGLE BAR GRAPH ................................................................................................................................................ 16
  EXAMPLE 2 – MULTIPLE BAR GRAPH ........................................................................................................................................ 17
  EXAMPLE 3 – MULTIPLE LINE GRAPH WITH A GAP/TARGET ....................................................................................................... 18
  EXAMPLE 4 – MULTIPLE LINE GRAPH USING QUARTERLY DATA .................................................................................................. 19
  EXAMPLE 5 – STACKED BAR GRAPH ........................................................................................................................................ 20
  EXAMPLE 6 – MIXING GRAPH TYPES ........................................................................................................................................ 21
ADDING DEPARTMENT KEY PERFORMANCE INDICATORS ......................................................................................... 22
ADDING PRIORITY PROGRAM DESCRIPTIONS .............................................................................................................. 23
SUPPORT ............................................................................................................................................................................. 23
System Overview

The Performance information collected in the Alaska Budget System is used for:
- Communicating performance information to the public, OMB, and Legislature
- Reporting agency performance in the Budget Book produced by the Alaska Budget System’s (ABS) Operating Module

While working with the system, keep in mind that there are two modes where information can be edited:
- Published Mode – data entered will be uploaded to the public website.
- Draft Mode - data entered is not viewable by the public until the “approve change” option is selected.

Reporting Performance in the ABS Budget Book

The following pieces of information are collected by the Alaska Budget System. Some of the pieces are only viewable in the performance section of OMB’s website while others are printed in the Budget Book report released annually on December 15th.

<table>
<thead>
<tr>
<th>Value</th>
<th>Viewable on Web</th>
<th>Included in Budget Book</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mission</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Core Services</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Results</td>
<td>Yes</td>
<td>No</td>
<td>While not used in the budget book, targets are listed by result on the public website.</td>
</tr>
<tr>
<td>Targets</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Yes</td>
<td>No</td>
<td>The table of data can be optionally shown on the website.</td>
</tr>
<tr>
<td>Table Graph</td>
<td>Yes</td>
<td>Yes</td>
<td>Since the target’s graph is the only thing included in the budget book, every target should have a graph.</td>
</tr>
<tr>
<td>Analysis</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Links</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

Accessing the System

The performance data entry is contained within the Alaska Budget System. Permissions can be limited to just performance data entry. Requests to add, modify, or delete users to the system should go through your department’s budget manager.

If a department wants to limit the department, RDU, and components a user has access to, this is done through the User/Group Security options within the Alaska Budget System available to authorized operating users.

Access to ABS is restricted to those on the state’s wide-area network or through a VPN.

The public Performance site can be found on the Office of Management & Budget’s website at http://omb.alaska.gov
Browsing your Budget Structure

Access to performance data can be done either through the File->Open Performance menu item or through the File->Open Operating Browser (if user has operating access). If you have access to the operating budget module of ABS, the performance data can be found on the core services tab of the department, rdu, and component edit windows.

When using the Performance browser, click on the name of the item for which you want to add or modify performance information. The browser will default to only showing those structure items that already contain performance data, if you need to add new performance data click the Show All Filter in the upper right to access other RDUs/components.
The department, RDU, and component windows have similar layouts. The performance data can be found on the Core Services tab.

Department authorized operating users can restrict edit capability to select Dept/RDU/Components through the Tools->User/Group Security – Operating menu interface.

Published vs Draft Edit Modes

Information on the Performance windows can be edited in two modes – Published and Draft. The edit mode is displayed in the upper right corner of the window. Published data will be uploaded to OMB’s website and included in the budget book.

Published Edit Mode

Published mode is best for adding, editing, and deleting information which does not require any sort of approval process. Typically data updates are done in published mode because the targets have already been published and reviewed.

Draft mode can be used when edits require review prior to making public. This would be used when a new performance framework is being proposed or a new target.

Published targets cannot have their details edited in draft mode. To create draft changes to an existing target, duplicate the target in draft mode, make edits in the new draft version, and mark the published version for deletion. This way once all of the changes are approved, the new draft version will be swapped in place of the published version.
**Draft Edit Mode**

In Draft Mode, edits are not visible to the public until the “approve change” option is selected. This makes the draft version published and final.

The following chart summarizes the type of edits that can be done in Draft Mode:

<table>
<thead>
<tr>
<th></th>
<th>Revisions</th>
<th>Add New</th>
<th>Delete</th>
<th>Duplicate</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Results</strong></td>
<td>X</td>
<td>X</td>
<td></td>
<td>X*</td>
</tr>
<tr>
<td><strong>Core Services</strong></td>
<td>X</td>
<td>X</td>
<td></td>
<td>X*</td>
</tr>
<tr>
<td><strong>Targets</strong></td>
<td></td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td><strong>Tables, Graphs, Analysis &amp; Challenges</strong></td>
<td>Only on new Targets</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Delete also marks associated related information for deletion. For example, marking a result for removal would also mark the related core services and targets for removal as well.

In Draft Mode edits will appear:

- Red - for revisions to published information
- Purple – for new information added
- Strike Through Text – for sections of published information that are marked for removal

When editing a result or core service in Draft Mode, the published information will be read-only, and below it a new revised version can be entered. The Set link will duplicate the published version as a starting point and the Erase link will revert the item back to the published version by erasing the draft version.

After revising published information, the revised version appears in red when the page is viewed in Draft Mode.
If you want to propose the removal of a piece of information, click the Delete link while in draft mode and it will appear as strike-through text. Once marked for deletion, it can be restored but it cannot be further edited. If a result or core service is marked for deletion, all of the related targets will also be marked for removal.

If something new is added in Draft Mode, it will appear purple.

To approve changes and make them visible on (or delete from) the public website and budget book, click on the Approve Change link next to each item or click on the Approve All Draft Changes link in the upper right under the edit mode.

**Things to be aware of in Draft Mode**

- Tables, graphs, and the Analysis cannot be edited in draft mode for published targets – a duplicate draft version of the entire target needs to be created. The Duplicate option can be used to create a proposed “new” target by duplicating the existing target, and then the old copy could be marked for removal, and any changes are then made in the new copy. This option must be used if you want to make changes to the table, graph, or analysis & challenges section while in draft mode.

- Delete: A result marked for deletion will also mark any related core services and targets for deletion. Likewise, a core service marked for deletion will also mark any related targets for deletion

- New information (purple) which has been added in Draft Mode will be permanently deleted if you click on the Delete link.

**Restrictions in Draft Mode include:**

- Sort orders cannot be changed in Draft Mode.
- When editing a core service, the linkage between the core service and the result it supports cannot be changed.
- Published tables, graphs, and the analysis & challenge section cannot be edited in draft mode

**Other notes related to Draft Mode:**

- Draft information is not transferred to the public website or included in the budget book.
There is currently no user-level security associated with who can approve changes in draft mode. At this time, it is up to departments to determine how the Draft Mode feature will be used and who should be approving proposed changes.

If you want to create a MS-Word document comparing the published and draft changes you can run two versions of the same RTF report, one in Published and one in Draft Mode (ABS report #1808 vs #1809), and then use MS-Word’s “Compare and Merge Document” feature under the Tools menu to create a document showing the changes. This is helpful for having agency people who are not Performance site users review changes.

End Results & Core Services

Each RDU/Component can have one or more Results and Core Services. Each Core Service must be linked to one Result. While Results themselves are not printed in the budget book, the targets associated with Results are printed after the mission statement for RDUs and components. For the department level, select key performance indicator targets are printed by priority program as the department-level core services. The department level does not have the same core service options that RDUs and components have but instead uses department priority programs.

Click the Add Result or Add Core Service links to create a new result or core service.

Changes are saved when the window is closed.

New results and core services will be added to the end of the table and will be printed in the order they were added to the system unless you specify a different sort order. The display order can be changed by clicking on the Sort Results or Sort Core Services links.
Left click with your mouse on a core service and drag it into the desired sort order.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Conduct hearings and alternative dispute resolution processes to resolve administrative cases (appeals and original actions).</td>
</tr>
<tr>
<td>2</td>
<td>Provide Training for Administrative Adjudicators</td>
</tr>
</tbody>
</table>
Targets

To view specific targets within a Result or Core Service, click on the Edit Targets link to the right of the title. The quantity of targets will be shown in parantheses.

The target listing window:

Click the Add new target link to create a new Target for the result or core service. New targets will appear at the end of the target listing and be displayed in the order they are entered, the order of the targets within a result or core service can be changed by clicking on the Sort Targets link.

To edit the details of a target, click the Edit link to the right of the target title.

Click the Delete link next to a target to delete them.

Targets can be duplicated as a starting point for a similar target or in draft mode to propose edits to target details.
Editing Target Details

Key Performance Indicator – Optional value which defaults to None. When selected, the target will be displayed as a key performance indicator under the selection department priority program.

Target – Required value which describes what is to be measured and the desired target to be reached.

Title – Option title which will appear at the top of the graph.

Data table – see next section.

Analysis - optional long text field where you can include additional information about the target. This is the agency’s opportunity to further describe the progress made toward the target and challenges encountered.

Links – optional URLs to other web sites which contain related information about the target. The links are not used by ABS and only appear on the web site.

Editing a Target’s Data Table and Graph

Each target can have one table of information. To create consistency between the various state agencies, many limits have been placed on the table layout and graph options. The graphs presented in the budget book are generated from the data table.

Adding a title for the table/graph is optional. The title can be up to 255 characters long. Each table can have a maximum of 7 columns and each column can be 24 characters long. All of the column headers can be renamed for custom uses. Unused columns can be hidden from view in the printed table by checking the “Hide” checkbox at the bottom of the column.
Each row of the table must represent a year or quarter’s worth of data. The time period of the year can be clarified by choosing Calendar, Fiscal Year, or Federal Fiscal Year from the choices at the top of the table. If you choose the “Fiscal Year” option, the years will be displayed with an “FY” in front of all years (eg FY2004 instead of simply 2004). If you choose the “Federal Fiscal Year” option, the years will be displayed with an “FFY” in front of all years. The YTD column default is to represent a year-to-date total with columns 1-4 assumed to be quarters but this is not a required layout. The last two columns can be used to show a Target value and Variance from the target. The “Visibility” checkbox for each row determines if the information will be displayed to the public and transferred to the website and included in the budget book. It may be useful to hide data until it is approved by unchecking the visible option for certain rows. The “Compute YTD” setting controls the display of the “YTD Total” Column. If Compute YTD is set to “Values,” the YTD column will automatically total the numbers in the first four columns. If Compute As is set to “Text,” whatever the user types in the YTD column will be displayed without any calculations being made. The rows will be sorted in descending order so the most recent year appears on top. Permanently remove rows using the Delete link on the right side of the row.

The Methodology field is used to describe the methodology used for the collection of the data in the table and should be filled in for all targets.

When the table is displayed on the web or the budget book, a percentage change between rows can be optionally added below each value. This calculation will not be made if one of the values to be compared is not a number or if you uncheck the “Show % change” option at the top of the table.
Creating Graphs from Tables

Each target can have one table and one graph based off of data in the table. The table does not have to be visible (all columns can have Hide field checked) to display the graph. Multiple columns of data from the table can be displayed on a single graph. Currently supported graph types include bar graphs, line graphs, stacked bar graphs, and some combinations of these types. The contents of the Methodology field below the table will be displayed below the graph.

Shared fields between tables and graphs:

**Title** - The title of the graph will be used as the title of the table.

**Year** – The first column of the table containing the year is used as the horizontal axis (x-axis) of the graph.

**Column values** – Each column of data represents one potential plot of data in the graph. The range of values entered in the cells of the column determines the vertical axis (y-axis) scale used in the graph.

**Column headers** – If more than one column of data is plotted on the graph, the column headers of the table will be used to create a legend. If only a single column of data is displayed in the graph a legend is not displayed.

**Calendar/Fiscal Year/Federal Fiscal Year** - Every graph uses the first column's values as the horizontal axis. This field determines whether the horizontal axis is labeled “Year”, “Fiscal Year”, or “Federal Fiscal Year”.

**Visible** - Whether this value is checked or not for each row affects which years are displayed in the graph. If this value is unchecked, the entire year will be ignored when the graph is created.

**Hide** - Allows for a column in the data table to be hidden. Whether this value is checked or not has no effect on whether the data in the column is displayed in the graph. Checking this value and setting the Graph As value to something other than None allows you to display data in a graph without having to display the table below the graph.

Fields exclusively added for the graphing feature:

**Graph As** – This field controls which columns of data will be graphed and the type of display the graph uses for the data. If any column has a value other than None a graph will be created. To remove a graph from a table, mark all of the columns as None. Different graph display types can be selected for each column and combined on a single graph. The available choices are:

- **None** – The data in the column is not graphed (default).
- **Line** – The column’s data will be used as a line graph.
- **Bar** – The column’s data will be used as a bar graph.
- **Stack** – The column’s data will be used as a stacked bar graph along with any other columns marked as Stack.

**Color** – Determines the color of the line or bar. Suffixes of Lt and Dk represent lighter and darker shades.
**Show value in graph** – Determines whether each plot point displays the cell’s value within the graph. For example, the exact value would show in the graph at the top of a bar in a bar chart or at a data point in a line graph.

**Translucent** – Changes the bar or line to translucent. This can be helpful when combining line and bar graphs or displaying values within the graph to improve appearance.

**Override vertical axis scale** – This minimum and maximum value can be used to override the vertical axis scale. The graph will usually pick a logical range for the given values given but if you want to override these values with a larger or smaller range, enter a non-zero amount in at least one of these two fields.

---

**Technical Tips and Known Issues with Graphs**

- If you want to graph data by quarters, select the year-quarter values in the year dropdown (2006-Qtr1, 2006-Qtr2, etc) in the first column of the table and override the default quarter table column header titles to reflect your data.

- Columns of data from left to right are presented in stacked bar graphs from bottom to top.

- Stacked bar graphs and regular bar graphs cannot be combined because stacked bars draw over the top of regular bar graphs. Stacked bar graphs are best combined with a line graph if needed.

- The only symbols that are allowed in graphed column values are $, %, decimals, and commas. Any other symbols or letters will create an error or be treated as zero as the graph is generated because they are not interpreted as numerical information.

- The presence of $, %, or decimals in the data being graphed will cause the vertical axis scale to be formatted similarly. If more than one format is present, the format of the last graphed column in the table from left to right will be used.

- You don’t have to display a table to have a graph. You can check the Hide box for all of the columns in a table and still have the graph display.
**Graphing Examples**

The following pages show example graphs and the table information used to generate them.

**Example 1 - Single Bar Graph**

![Single Bar Graph](image)

**Example 2 - Multiple Bar Graph**

![Multiple Bar Graph](image)

**Example 3 - Multiple Line Graph with a Gap/Target**

![Multiple Line Graph](image)

**Example 4 - Multiple Line Graph using Quarterly data**

![Multiple Line Graph](image)

**Example 5 - Stacked Bar Graph**

![Stacked Bar Graph](image)

**Example 6 - Mixing Graph Types**

![Mixing Graph Types](image)
**Example 1 – Single Bar Graph**

The following table settings produce a bar graph which plots a single column’s worth of data. The first column’s “Graph as” value has been changed to Bar, the color Blue chosen, and the Show value has been checked so the numbers are shown above each bar. The Y axis maximum value has been increased to 150000 using the override vertical axis scale.

![Performance Target: Charter, license or register entities and persons in regulated financial services industries.](image)

![Alaska Chartered, Registered, Licensed or Examined Financial Services Entities and Agents](image)
### Example 2 – Multiple Bar Graph

The following table settings produce a multiple bar graph which plots two sets of data for each year. The first and second columns’ “Graph as” value have been changed to Bar, the colors Red and Blue are chosen, and the Show value has been set to none. The vertical axis had defaulted with a maximum value of 6, so the vertical axis minimum and maximum have been overridden with values of 0 and 7.

<table>
<thead>
<tr>
<th>Year</th>
<th>Fatalities</th>
<th>Avg Fatalities</th>
<th>YTD Total</th>
<th>Quarter 7</th>
<th>Visible</th>
<th>Compute YTD?</th>
</tr>
</thead>
<tbody>
<tr>
<td>2021</td>
<td>3</td>
<td>6</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2020</td>
<td>5</td>
<td>6</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2019</td>
<td>4</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2018</td>
<td>1</td>
<td>6</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2017</td>
<td>5</td>
<td>6</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Override vertical axis scale with Min. 7.000 Max. (leave blank or 0 for autoscaling)
Example 3 – Multiple Line Graph with a Gap/Target

The following table produces a multiple line graph and uses blank cells to create a target point at the end. The first 5 columns are marked as Line to show the various quantities of harvested fish types over the years. The target column of the table is also marked as Line but has the data erased for all but the last row, this produces a single point of data at the far right which can be used to show a target.

<table>
<thead>
<tr>
<th>Add Row</th>
<th>Year</th>
<th>Rainbow</th>
<th>Coho</th>
<th>Chinook</th>
<th>Other</th>
<th>YTD Total</th>
<th>Target</th>
<th>Variance</th>
<th>Visible</th>
<th>Compute YTD?</th>
</tr>
</thead>
<tbody>
<tr>
<td>2022</td>
<td></td>
<td>100000</td>
<td>75000</td>
<td>30000</td>
<td>60000</td>
<td>265000</td>
<td>175000</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2021</td>
<td></td>
<td>65000</td>
<td>55000</td>
<td>45000</td>
<td>40000</td>
<td>205000</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2020</td>
<td></td>
<td>70000</td>
<td>60000</td>
<td>40000</td>
<td>40000</td>
<td>210000</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2019</td>
<td></td>
<td>50000</td>
<td>68000</td>
<td>45000</td>
<td>40000</td>
<td>203000</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2018</td>
<td></td>
<td>45000</td>
<td>50000</td>
<td>35000</td>
<td>50000</td>
<td>180000</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2017</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Graph as: Line Line Line Line Line None
Color: RedLt BlueLt GrnLt GoldDk Red Black Black
Show value: 
Translucent: 
Override vertical axis scale with: 0 Min: 300000.0000 Max: (leave blank or 0 for autoscaling)
Example 4 – Multiple Line Graph using Quarterly data

The following table settings produce a multiple line graph for a single year. The first and second columns’ “Graph as” value have been changed to Line, the colors Green and Blue are chosen, and the Show value has been set to Top for the first column and Bottom for the second. The y-axis had defaulted with a range of 66% to 82% so the vertical axis minimum and maximum have been overridden with values of 0 and 100. The vertical axis labels automatically format with a percentage sign due to the presence of percentage symbols in the data.
**Example 5 – Stacked Bar Graph**

The following table settings produce a stacked bar graph for multiple years. The first, second, and third columns’ “Graph as” value have been changed to Stack.

![Stacked Bar Graph Example](image)

- Title: Projects Reviewed by ACMP
- Fiscal Year: [Select options]
- Show % Chg: [Check-box]

<table>
<thead>
<tr>
<th>Year</th>
<th>Consistent</th>
<th>Inconsistent</th>
<th>Q4</th>
<th>YTD Total</th>
<th>Target</th>
<th>Variance</th>
<th>Visible</th>
<th>Compute YTD?</th>
</tr>
</thead>
<tbody>
<tr>
<td>2023</td>
<td>131</td>
<td>49</td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>True</td>
<td>Delete</td>
</tr>
<tr>
<td>2022</td>
<td>140</td>
<td>52</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>True</td>
<td>Delete</td>
</tr>
<tr>
<td>2021</td>
<td>168</td>
<td>76</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>True</td>
<td>Delete</td>
</tr>
<tr>
<td>2020</td>
<td>168</td>
<td>115</td>
<td>7</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>True</td>
<td>Delete</td>
</tr>
</tbody>
</table>

- Hide: [Check-boxes]
- Graph as: [Stacked, Stacked, None, None, None, None, None, None]
- Color: [RedLt, BlueLt, GoldDk, GoldDk, Red, Black, Black]
- Show value: [Values]
- Translucent: [Values]
- Override vertical axis scale: [0, Min 0, Max (leave blank or 0 for autoscaling)]
- Methodology/
Example 6 – Mixing Graph Types

The following table settings produce a mix between a bar and line graph for multiple years. The first column of the table contains the yearly harvest data and has the “Graph as” option set to Bar. The Target column of the table is used to show a cross-year goal of 70% by selecting Line as the “Graph as” value. The Translucent option has been selected to make the values more visible within the blue bars.

<table>
<thead>
<tr>
<th>Select Year</th>
<th>Harvest</th>
<th>Q2</th>
<th>Q3</th>
<th>Q4</th>
<th>YTD Total</th>
<th>Target</th>
<th>Variance</th>
<th>Visible</th>
<th>Compute YTD?</th>
</tr>
</thead>
<tbody>
<tr>
<td>2023</td>
<td>32%</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>70%</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2022</td>
<td>41%</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>70%</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2021</td>
<td>65%</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>70%</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2020</td>
<td>54%</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>70%</td>
<td>0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Hide: |
| Bar | None | None | None | None | Line | None |

| Color: |
| Blue | Light Blue | Gold Dark | Gold Dark | Red | Black | Black |

| Show value: |
| Bar | None | None | None | None | None | None |

| Translucent: |
| Bar | None | None | None | None | None | None |

| Override vertical axis scale with: |
| 0 | Min. | 0 | Max. (leave blank or 0 for autoscaling) |

Percent of Fisheries Within Amounts Necessary for Subsistence

- Harvest
- Target

Calendar Year

2020 2021 2022 2023

Draft!
Adding Department Key Performance Indicators

Key Performance Indicators are specially selected targets, selected by the department from the department’s performance framework at any level (Dept/RDU/Component), that best reflect results achieved with current capacity.

Key Performance Indicator targets are selected at the top of the Edit Target window in ABS. The value will default to None and has a dropdown of the available Department Priority Programs.

Key Performance Indicators display only at the Department Level on the website and in budget narrative. They may be selected from any budget structure level in the Department’s performance framework. Remember that only the graph associated with a target will be printed in the ABS budget book but all of the details entered for a target are available on the public performance website.
Adding Priority Program Descriptions

Contact your OMB analyst to update the description posted underneath the priority programs when uploaded to the website. The descriptions are found under Tools->Maintenance – Operating->Programs – Department.

The description should include what the program encompasses – program activities, components, other entities, special initiatives or other information that helps the reader understand what is included in the program and identify program activities with budgeted resources. Please consider wording carefully. Space is limited to 350 characters. The master list of department priority programs is maintained by OMB analysts.

Support

OMB is available to support site administrators in two key ways: 1) Technical support; OMB’s IT section should be contacted regarding questions or concerns with the technology itself, and 2) Management consulting; OMB’s budget analysts are available to address questions or to provide advice on Performance initiatives and presentation format.

Technical support: Will Belknap, 465-4674, will.belknap@alaska.gov